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How to Use this eGuide

This eGuide was designed to be read with Adobe Reader, which is a free 
program for all Mac and Windows computer users. You can download the 
latest version of Adobe Reader at http://get.adobe.com/reader. Guide 
functionality may vary depending on your reading device.

In addition to reading about your health, you can use this eGuide to:

• Skip to speci�c topics. Click on any section heading to skip to that topic.

• Search for a speci�c topic. On the menu, go to Edit>Find. Type in your 
search word, followed by the Return key. Search results will be highlighted. 
Continue to hit Return key to skip to the next result.

• Look up unfamiliar words. Use the cursor to highlight a word (for example, 
“diabetes”). On the menu, go to Edit>Look Up “diabetes.” Your internet 
browser will open to provide more information about this word.

• Track your health information. Places to enter your information appear in 
blue. Click on any blue �eld and begin typing. Use the Tab key to skip to the 
next �eld or the Return key if you are done. Don’t forget to save your 
changes before you close the document.

Concerned about keeping your information private? Edit your security 
settings: On the menu, go to Edit>Protection>Security Settings.

• Make note of health questions or concerns about what you are reading. On 
the menu, go to View>Comment>Annotations. Choose Sticky Note. Click 
where you would like to insert a note and begin typing.

• Learn more from internet resources. Click on any web address to open that 
web page in your internet browser.

• Hear the guide read aloud to you. First, activate this feature. On the menu, 
go to View>Read Out Loud>Activate Read Out Loud. Then, go back to the 
same place in the menu to begin, pause, or end reading aloud.



Pregnancy, childbirth, and beginning parenthood are a
huge undertaking.  Knowing what to expect will ease
your mind.  TheAmerica’s Pregnancy Health GuideTM

offers information about:

� Prenatal Care � Complications
� Risk Factors � Labor and Delivery
� Tests � Newborn Care
� Record of Checkups � Resource List
� Body Changes

This guide will also be a record of your prenatal care.
Carry it with you.  Information will then be handy during
your visits to a health care provider, when traveling, and
in case of an emergency.  Use the plastic sleeve to
protect and store your insurance card, appointment
cards, or an ultrasound photo of your baby.  This book is
also a helpful record for future pregnancies.

Information in the Pregnancy Health Guide is for education
only.  It does not replace medical advice or attention.  We
cannot accept responsibility for any problems that may
develop.

Pewaukee, WI 7th Edition © 2010 HealthStyle Press PRINTED IN U.S.A.
www.healthstylepress.com
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Plan and Take Care

PRE-PREGNANCY PLANNING
It is ideal to plan ahead to improve your health before
you are pregnant.  This offers the best chance of having a
healthy pregnancy and a healthy baby.

There are lifestyle changes that you can make before
becoming pregnant.

� Eat a balanced diet.
� Give up smoking.
� Stop drinking alcohol.
� Begin taking folic acid.
� Take care of your teeth and see a dentist.

Any woman who could become pregnant or is thinking
about it should see a doctor, who will screen for risk factors
or problems.  Vaccinations for Rubella and Hepatitis B and
screening for HIV is also needed.  It is important to manage
asthma, diabetes, obesity, sexually transmitted diseases,
and inherited disorders.
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PRENATAL (BEFORE BIRTH) CARE
Prenatal care is the health care you receive while you are
pregnant.  You’ll probably visit your doctor 10 or more
times before your baby’s birth.  Women who begin
prenatal care early in pregnancy have a much better
chance of delivering healthy babies. 

If you have no health care provider, ask a family
member or friend.  Your local health clinic, health
department, hospital, or pregnancy hotline can also give
you a referral.  You may choose a certified nurse midwife,
family doctor, or an obstetrician.  An obstetrician is a
doctor trained to take care of pregnant women.
Midwives can care for women with normal pregnancies.
A doctor is needed if problems are expected or develop.

Home pregnancy tests are easy to use.  They can detect
pregnancy as early as two weeks after a missed period.  If
you think you are pregnant, make an appointment with
a doctor right away. 

Your doctor will oversee and manage your pregnancy to
protect your health and your baby’s.  You will have: 
� A complete physical examination to check your
general health. 

� A pelvic exam to check the organs of reproduction. 

� A Pap test to check for cancer. 
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� Your height, weight and blood pressure recorded. 

� Blood and urine samples taken for tests related to
your pregnancy and general state of health. 

Other tests may be done at this time or later for specific
medical reasons.

Know the date you began your last period. It will be used
to figure your due date.  This will be about 40 weeks
from the first day of your last menstrual period.

Don’t miss appointments even if you feel fine.  Your doctor
will check how you and your baby are doing.  He or she will
manage existing or likely future problems.  Use these visits
to build a good relationship with your health care providers.
They want to know how things are going in general. 

If you are under extreme stress or feeling depressed, talk
to your doctor about treating these conditions.  Do you
have concerns about being a single mom?  Are you
thinking about adoption?  The more your doctor knows,
the better he or she is able to help you.

Childbirth classes help prepare couples for pregnancy,
labor, and newborns.  They also teach about breast-
feeding.  Ask for referrals to childbirth classes.
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RISK FACTORS
Everything that goes into your body goes into your
baby—what you eat, drink, breathe, what drugs you
take.  Everything you do affects your baby—how you
live, work, sleep, play.  Your baby depends on you to
protect it from harm.  Make healthy choices.  Show your
love for your baby by avoiding habits and hazards that
add risk to your pregnancy.

If you are pregnant and drink alcohol, smoke, or use
illegal drugs, stop right away.  Get help if you need to.

� Babies of women who drink alcohol during
pregnancy are at risk for birth defects.  Fetal alcohol
syndrome can include both physical and mental
birth defects.  It is best not to drink alcohol at all
while you are pregnant.

� Pregnant women who smoke are more likely to
have miscarriages, stillbirths, preterm labor and
premature babies than women who do not smoke.
Babies may be too small.  They may have birth
defects. They may also have slow physical growth and
mental development.  Secondhand smoke is also
harmful.  If you smoke, ask your doctor to help you
stop smoking.

� Women who use addictive (usually illegal) drugs
are more likely to have a miscarriage and other
problems.  Half of all infants born to addicted mothers 



are addicted.  Most suffer withdrawal.  Some do not live.
Those who do live may have birth defects, brain
damage, and slowed growth and function of organs.
Even if drugs are used once, they may be harmful.

� Almost any drug you take while you’re pregnant
affects your baby.  This includes prescription drugs
and over-the-counter drugs like aspirin or cough
syrup.  Some substances cause birth defects and
other serious problems.  Even too much of some
vitamins, like Vitamin A, may cause birth defects. You
may need medicine for a health problem.  Your
doctor knows what is safe and should supervise all of
your medicines.

� Some infectionsmay cause birth defects.  Genital
herpes, hepatitis, influenza, mumps, German measles
(rubella), and chickenpox (varicella) are a few.  There
are others.  Be tested and treated so your baby is not
infected.

� Some sexually transmitted diseases (STDs) may
cause infant deformities, blindness, deafness or
death.  If there is a chance you or your partner has an
STD, be tested and treated.  Protect your baby.

� Avoid x-ray exposure of your belly. Tell your dentist
and other health care providers you are pregnant.

5



6

� Some chemicals change the way a baby’s brain
develops.  Avoid exposure to hazardous materials
such as cleaning solvents, lead, mercury, insecticides,
paint, and stains.

� A parasite found in cat feces and in some meat may
lead to a miscarriage.  Rarely, it can cause blindness
and death of an infant.  

• Do not handle litter boxes or anything dirtied by
cat feces.

• Eat only well-cooked meat. 

• Wash your hands after you handle raw meat or
unwashed produce.

� If a mother’s blood is Rh-negative and the father’s is
Rh-positive, the mismatch of this blood factor may
destroy the baby’s red blood cells.  Injections may be
given during and after pregnancy to prevent
problems.

� Age is a risk factor.  Women older than 35 are more
likely to develop diabetes and high blood pressure.
They also may be more likely to have a baby with a
genetic problem such as Down syndrome.  Girls age
15 and under are more likely to develop serious
problems during pregnancy.  Overall, mothers and
babies do well in most cases if mothers are healthy
and have good prenatal care.
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TESTS
Tests are done before, during, and after pregnancy.  They
help find problems and decide what treatment is needed.
Tests can also find out the baby’s gender, health status,
and some development problems.  Always ask why a test
is done, any risk, and the results. 

Most pregnancies are low risk.  Routine tests of mother
and baby simply make sure all is going well.  Some
special tests may be done for Down syndrome, spina
bifida, Tay-Sachs, sickle cell disorder, and other problems.

Blood Tests
First visit:

� Blood type and Rh factor.

� Rubella immunity.

� Screen for anemia.

� Check for sexually transmitted diseases.

� HIV testing for the virus that causes AIDS.

� HBV test for the virus that causes Hepatitis B.

� TSH to identify low thyroid function.
15–20 weeks: 

� Triple Screen.  This combination of three tests
screens for defects such as spina bifida and genetic
problems such as Down syndrome.

Write down when you have these tests in the
Prenatal Checks record.
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24–28 weeks: 
� Diabetes Mellitus Screen (DMS) checks for high
blood sugar.  If this level is high, a Glucose
Tolerance Test (GTT) to check for diabetes will be
needed.

Urine Tests
Every visit:

� Check for sugar in urine, which can be a sign of
diabetes.

� Check for increased levels of protein to find problems
with kidneys, high blood pressure, or preeclampsia.

� Bacteria may reveal a urinary tract infection.

Pelvic Exams
First visit:

� Pap test done during exam of the cervix (opening
of the uterus).  Test screens for cervical cancer.

35–37 weeks:
� Bacterial culture to check for Group B Streptococcus

(GBS).  This bacteria can cause a newborn to
become sick.  Mother can be treated with
antibiotics during labor.

Amniocentesis*
After 16 weeks:

� A test of fluid around the developing baby to check
for genetic conditions.  This may also be done later
in pregnancy to determine the lung maturity of the
baby if early delivery is a concern.



9

Chorionic Villus Sampling (CVS)*
10–12 weeks:

� A sampling of tissue from the baby’s portion of the
placenta to check for genetic conditions.

Heartbeat
After about week 12: 

� Your health care provider will listen to your baby’s
heartbeat.  You may be allowed to hear the
heartbeat too.

Ultrasound
18–20 weeks:

� A method of getting a picture of the developing
baby using sound waves.  It can be used to
measure growth, estimate age, check for more
than one baby, determine the baby’s position, and
locate the placenta.

Non-stress or Stress Test (NST)(OCT)
Near end of pregnancy:

� A fetal monitor evaluates the baby’s current heart
rate patterns.

Write down when you have these tests in the
Prenatal Checks record.

*Not all pregnancies
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Weeks
Pregnant

Prenatal Health Checks

Visit 1

Weight Blood
Pressure

Fundal
HeightDate

Visit 2

Visit 3

Visit 4

Visit 5

Visit 6

Visit 7

Visit 8

Visit 9

Visit 10

Visit 11

Visit 12

Urine

Visit 14

Visit 13
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Fill in information 
when you have these check-ups and tests.

Providers: Please assist with record completion.

FHT Fetal
HeartTones Tests Seen By:



Your Changing Body

Most women do not have serious problems during
pregnancy.  Some discomfort is common.

BODY CHANGES
Nutrition: A healthy diet is vital for both you and your
baby.  

� You will need about 300 extra calories per day, eating
a variety of healthy foods that includes low-fat dairy,
protein, and lots of fruits and vegetables.  

� A slow, steady weight gain of 25 to 35 pounds is best
for a healthy baby.  

� Pregnant women need 1500 mg of calcium per day.
You need iron for the extra blood supply for mother
and baby.  Most doctors prescribe prenatal vitamins
with iron and folic acid. 

� Limit caffeine to less than 200 mg a day.

Urination: It is normal to urinate often.  Your body has
added fluids.  As the uterus grows, it puts pressure on the
bladder.  Report if you have burning or pain when you
urinate, discolored urine, or a backache.  That may be a
sign of infection.  Don’t cut down on fluids, you need to
drink lots of water.  Try drinking earlier in the day so your
sleep is not disturbed.

12
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Swelling: Fluid makes up about a fourth of weight gain.
Avoid highly salted foods. Put your feet up whenever
possible.  Avoid standing for long periods of time.
Report sudden or increased puffiness in your hands, and
face, and especially around the eyes.  This may signal a
serious problem.

Breast care: Breasts increase in size and are more
tender.  Colostrum (yellowish “early milk”) may leak from
the nipples in the last months.  Keep them clean with
warm water and gentle washing.  Your health care
provider can help you prepare for breast-feeding.

Mood Swings: It is normal to be more emotional as
your body and hormone levels change.  You may cry for
no reason.  You may think about how a baby will change
your lifestyle.  You may worry about how you will
manage.  Talk over your feelings with others, especially
family.  They are most often affected by your moods. 

Pamper yourself.  Plan and do things with your partner
or friends that bring you pleasure.  Get plenty of rest.  Tell
your doctor if you think you are depressed. 

Vaginal discharge: A thin mucous discharge is normal.
If the discharge is excessive and has an odor, or if you
have itching or burning in the area, contact your doctor.
You may have an infection.  Report any bleeding or
sudden fluid discharge immediately.
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DISCOMFORTS
Morning Sickness/Nausea: Nausea and vomiting are
common during the first part of pregnancy.  For some
women, this is the first sign of pregnancy; others are
never nauseated.  If you experience this problem:

� Eat small, frequent, bland meals throughout the day.

� Try eating crackers or dry cereal before getting out of
bed.

� Eat foods that taste good to you.

� Tell your doctor if you are vomiting often.

� Take prenatal vitamins with meals.

� Lie down for a short time after eating.

Heartburn: Food stays in the stomach longer.  Stomach
juices are pushed back into the esophagus (food tube).
This causes a burning sensation under the breastbone.
It may leave a sour taste in the mouth.  

Eat four or five small, nourishing meals a day.  Food in
your stomach will soak up extra acid.  Eat slowly.  Avoid
whatever triggers discomfort, like spicy and fried foods
and carbonated drinks.  Don’t lie down until two hours
after you eat.  Try sleeping with your upper body raised
or lie on your right side.  Your doctor may suggest an
antacid.
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Constipation: As the uterus grows, it puts pressure on
the organs of digestion.  Eat foods with lots of fiber.
Fruits, vegetables, bran, and whole-grain cereal and
bread are great sources.  Prunes are often helpful.  Drink
at least 6 to 8 glasses of fluids a day.  Exercise daily.  If you
still have problems your doctor may suggest a mild
laxative or stool softener. 

Hemorrhoids:  Pressure on veins in and around the
rectal opening causes them to swell.  They may become
painful and itch.  Hemorrhoids often develop from
straining to have a bowel movement.  They are made
worse by constipation.  Tell your doctor if they bleed.

Varicose veins: Pressure from a growing uterus slows
blood return from leg veins.  They may become swollen
and painful.  Don’t stand or sit for more than a half-hour.
Walk around to aid circulation.  Put feet up on a footrest
when you are sitting.  Avoid anything tight around your
waist or legs; that further slows blood flow.  Tell your
health care provider about your varicose veins.

Sleep: Problems sleeping may mark your final months.
This is due to growing discomfort, frequent urination,
and a more active baby.  Do not eat a large evening
meal.  Limit evening fluids and avoid caffeine.  A warm
bath or shower might help.  Try different positions.
When you sleep on your side, prop pillows under your
belly, against your back, and between your knees.  Avoid
sleeping flat on your back.



TAKE CARE

Travel: Travel is usually safe.
However, if you are nauseated or
uncomfortable, it may not be
pleasant. Many doctors advise
against travel during the last weeks
of pregnancy.  When you travel,
change your position, stretch, and
walk around every hour.  

Always wear a safety belt in a car.
Fasten the lap belt low, across the hips and over your
upper thighs.  Never fasten it over your belly.  Adjust the
shoulder belt to the side of your belly and between your
breasts.

Headaches: Fatigue, tension, hunger, and stress can
cause headache.  Changes in hormones and blood
circulation are also common causes.  Practice relaxation
techniques.  Get enough rest, fresh air, and exercise.
Don’t skip meals.  If headaches are severe or do not go
away, call your doctor before you take any pain
medicine.  Also let your doctor know if you have vision
problems, sensitivity to light, vomiting, or fever with your
headache.

16



Exercise:  Exercise can help improve posture, strengthen
muscles, and promote relaxation.  Talk with your health
care provider before you start any exercise program.

� Start your exercise program slowly and increase your
activity level at a gradual pace.

� Avoid exercising while on your back after the first 
20 weeks.

� Don’t exercise in hot, humid weather.

� Body shape changes can cause a loss of balance.

� Avoid exercise involving any contact with the belly.

� Drink enough water and avoid overheating.

� Do Kegel exercises to strengthen the muscles in the
pelvic floor.  Tighten the muscles as if to stop the flow
of urine; hold for a few seconds.  Relax and repeat 10
or 15 times.  Do this several times a day. 

Backache: During pregnancy, joints of the pelvis
loosen.  Your posture and center of balance are changed
by the weight of your belly.  This adds strain to your
back.  Wearing comfortable, low-heeled shoes will help
good posture.  A well-supported low back (ask about a
back support belt) also relieves strain.  Try lying on your
left side with knees bent.

17



Some Complications of Pregnancy

HIGH RISK CONDITIONS
For some women, pregnancy doesn’t go as smoothly as
planned.  Not all high-risk conditions can be predicted.
Careful watching over high-risk pregnancies may greatly
increase the chances for a healthy delivery.

Pregnancy induced hypertension (PIH) is a serious
condition.  It occurs in mid to late pregnancy.  PIH is also
known as toxemia or preeclampsia.  If you have any of
these symptoms, call your doctor right away:
� Severe headaches.
� Dizziness.
� Excessive nausea or vomiting.
� Excessive swelling of feet and hands.
� Double or blurred vision.
� Pain in the upper abdomen.

Diabetes is a condition where sugar levels in the blood
are too high.  Diabetes that first shows up in pregnancy
is called gestational diabetes.  It usually goes away after
delivery but may come back later in life.  If you have
diabetes you’ll need to monitor your blood sugar levels
often.  A diabetes educator can help with meal and
activity planning.

18
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PROBLEMS IN  PREGNANCY
� Miscarriage is the loss of a fetus from natural causes
before the 20th week of pregnancy.  Most cannot be
prevented.  The cause may not be found.

� Stillbirth is the loss of a fetus from natural causes
after 20 weeks of pregnancy. 

� An ectopic (tubal) pregnancy is when an egg
imbeds in the wrong place.  It is most always in a
fallopian tube.  This causes internal bleeding and
severe pain.  It is removed by surgery.

� Abruptio placentae is the early separation of the
placenta from the uterus.  A small section may loosen
or it may completely separate.  When the placenta is
not connected completely, the baby’s source of food
and oxygen is cut.  There may or may not be painful
bleeding or a hard painful stomach. This is an
emergency. 

� In placenta previa, the placenta is low in the uterus.
If it is over the cervix, painless bleeding occurs.  Often
your doctor will find this condition early in pregnancy
so precautions are taken.
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� Preterm labor is when true labor begins between
the 20th and 37th week of pregnancy.  Preterm
babies have not had enough time to fully grow in the
womb.  They may be born with breathing or heart
trouble, brain damage, vision and hearing problems.

Symptoms that may mean preterm labor:
� Four or more uterine contractions per hour—
with or without pain.

� Menstrual-like cramps in the lower abdomen that
don’t go away.

� Abdominal or pelvic pressure, like the baby is
pushing down.

� Low backache.

� A gush or slow leak of fluid from the vagina.

� Vaginal bleeding.

� Postmaturity (prolonged pregnancy) occurs when
the baby is not born by the 42nd week.  If the due
date is correct, the doctor will induce (start) labor.

� Postpartum (after delivery) hemorrhage
sometimes occurs.  The uterine muscles may be too
weak and tired to contract enough to control
bleeding.  Drugs can contract the uterus and help
blood clot.



CALL YOUR DOCTOR
Call your doctor if you have any of these physical
changes:

� Bleeding from the vagina.

� Severe abdominal pain.

� Pain or burning when urinating.

� Puffiness in your face, hands, or fingers.

� Severe or sudden headache.  

� Vision problems or blurred vision.

� Lower abdominal cramping.

� A gush or slow leak of fluid from the vagina.

� Vaginal discharge that has a bad odor.

� Fever or chills.

� Severe nausea or vomiting.

� Greatly reduced or no fetal
movement after 28 weeks of
pregnancy.
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Ready for Baby

BE KIND TO YOURSELF
Being pregnant is an important job and it’s hard work.
You can feel lots of stress during pregnancy.  So talk to
your partner, family, and good friends.  Talk to your
doctor and nurse about how you feel.  If you have a
question—ask!

Baby Equipment Needed Before Baby Comes
� Car seat that meets safety guidelines. Bring this to
the hospital to take the baby home!
� Car seat should be in the backseat and face rear of
car for infants less than 22 pounds and one year of
age.

� Follow the installation instructions—make sure
the harness and car seat belt are snug.

� Crib that meet U.S. Consumer Product Safety
Commission standards, including:
� Slats that are no more than 2-3/8 inches apart.

� Mattress that fits snugly.

� Locks and latches that don’t release accidentally.

� Non-toxic paint/finish.

� Plastic-covered teething guards on rail.

22
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LABOR AND DELIVERY
Just as no two pregnancies are alike, the birth of each
child is also unique.  No one can predict how you or your
baby will respond.  However, there is a general course of
events.  Knowing what to expect ahead of time will help
you handle events as they occur. 

Childbirth is divided into three stages.  During stage 1
(labor) the cervix opens.  During stage 2 (delivery) the
baby passes through the cervix and out through the
vagina.  During stage 3 the placenta and membranes are
expelled.

Labor is a series of contractions of the uterus.  They help
open the cervix and push the baby down the birth canal.



24

SIGNS OF LABOR
Let your doctor know right away if you have any of these
signs.  Explain exactly what is going on.  If your
membranes rupture (water breaks), your doctor will
most likely want you to go to the hospital.  You will
probably deliver within 24 hours.
� A discharge of the red-tinged mucus that blocked the
cervix.

� Water (the sac with the amniotic fluid) breaks.  Clear
liquid leaks or gushes from the vagina.  Be sure to
note the time, color, odor, and amount.

� You are bleeding enough to need a sanitary pad.

� You are having true labor contractions at regular
intervals of time.  They get stronger, last longer, and
get closer together.  Walking does not stop them.
Pain usually begins at the lower back and spreads
through the abdomen.

During early labor, your cervix will begin to open (dilate)
and thin out (efface).  You will likely spend the majority
of this phase of labor at home.  During this phase of
labor:
� Focus on relaxing; don’t tense your muscles.

� Rest between contractions.

� Write down how often, how long, and how hard your
contractions are.

� Take a warm bath or shower (if your water has not
broken).
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� Drink lots of water.

� Don’t eat a heavy meal.

Your doctor will tell you when to go to the hospital.

AT THE HOSPITAL
You will most likely be in the hospital during active labor,
when strong contractions are 5 minutes apart or less.  The
cervix will dilate and contractions get stronger.  A monitor
may be put over your belly to measure the baby’s heart
rate and your contractions.  You will be working hard and
getting tired.  As the uterus contracts, the baby is pushed
against the cervix.  It slowly opens and thins until the
opening is large enough for the baby to pass through into
the birth canal.

If you move about, labor may go faster.  An upright
position makes the best use of gravity and puts less strain
on your back.  You may walk, stand, sit, or lay in a semi-
upright position.  An intravenous (IV) line may be put in to
give fluids and medications.  You will have vaginal exams
to see how labor is progressing.  If the cervix is not
opening as it should, medicine may be given.  This will
make your uterus contract more forcefully.  You may need
something for pain.  Anesthesia may be given. 

Transition is the most demanding and shortest period of
labor.  Your cervix will dilate fully.
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Pain Relief During Labor and Delivery
Some women rely on relaxation and breathing
techniques to relieve pain.  Others choose to have
medicine to relieve pain.  The type of medicine and how
it is given depend on several factors.  These include the
stage of labor, how much relief you need, what you
prefer, and what is best for you and your baby.  This
decision should be made when you are actually in labor.

� Analgesics/narcotics provide some pain relief.  They
also help you relax and rest better between
contractions.  They usually are not given close to the
time of delivery.

� Local anesthetics numb the area but do not keep you
from pushing.

� Regional anesthesia numbs the entire lower body.

Epidural anesthesia is used most often.
Medication is given through a thin tube placed
in the lower back.  Epidurals only partly affect
muscle control; you should still be able to push. 

Spinal anesthesia is mainly used for cesarean
births.  Medication is injected into the spine right
before delivery.

� General anesthesia is mainly used in emergency
cesarean deliveries.  You are put under anesthesia by
injection, inhaled gas, or both.
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BABY IS BORN
Delivering your baby can take anywhere from a couple
of minutes to three hours.  Things to expect during this
stage include:
� Contractions are close together and hard.  Work with
your caregivers and labor coach.

� You may have a strong urge to push but wait until your
doctor or nurse tells you to; the cervix may not be ready.

� If the vaginal opening is not wide enough, a small cut
(episiotomy) may be made between the vagina and
rectum.

Most babies are born headfirst, with face toward the
back.  A baby in any other position may need special
help to be born.  They may be feet or buttocks first
(breech), head down but face up (posterior), or crosswise
(transverse).  A doctor may be able to turn a breech
baby.  A cesarean section is always done if the baby is in
the transverse position.  It may also be done for other
abnormal positions.

As you push, the baby’s head comes out first.  Mucous
and fluid are removed from the mouth and nose.  Then a
few more pushes and your baby is born.  Baby takes a
breath of air and might cry.  The umbilical cord is
clamped and cut.  Your baby girl or boy may be placed
on your stomach or even put to your breast.  You are
exhausted and emotional. 
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Cesarean Birth
A cesarean section may be needed to safeguard the
mother, the baby, or both.  It can be planned ahead or
done when an unexpected problem occurs.  Incisions
are made in the mother’s abdomen and uterus and the
baby is lifted out.  The mother usually is given regional
anesthesia which allows her to be awake but feel no
pain.  A cesarean section may be done if: 
� Labor doesn’t fully open the cervix.

� Baby is too large or is in an abnormal position.

� Baby or mother show signs of distress.
� Baby is premature.

� There are multiple babies.

� Mother has PIH, diabetes, or an active vaginal
infection.

� There are problems with the placenta.

AFTER BIRTH
Know that babies are not born “picture perfect.”  They
may be hairy, wrinkled, and puffy-eyed.  The head may
be misshapen and the body covered with a greasy white
coating.  These features quickly change.  By the time a
baby arrives, parents already have a strong emotional
link.  Now your baby also begins to form a bond, one
that will grow through life.



The third stage of labor is delivery of the placenta.  A few
mild contractions will usually empty the uterus.  If you
had an episiotomy or tear, it will be stitched.  You will be
checked closely to make sure that all is well.  After a well-
deserved rest, you will be up and about.  Walking helps
relieve gas pains and increases circulation for faster
healing.  You will be sore.

You may have mild cramping as the uterus begins
getting back to its normal size.  Often this occurs during
breast-feeding.  Your baby may be in your room or
brought to you every 2 to 4 hours to be fed and loved.
Nurses will teach you how to care for yourself.  They will
also show you how to bathe, feed, and care for your
baby.  This is the time to ask questions.

29



30

CORD BLOOD DONATION
Besides nourishing your baby during pregnancy, cord
blood can save lives.  After a baby is born, the umbilical
cord and placenta are no longer needed.  They are
usually discarded.  However, the blood remaining in the
umbilical cord and placenta is rich with blood-forming
stem cells.  (These are not embryonic stem cells.)  By
collecting and freezing this blood, the healthy blood-
forming cells can be stored.  A patient who needs them
may later use the cells.

For patients with leukemia, lymphoma, sickle cell
disease, or certain inherited disorders, a cord blood or
bone marrow transplant may be their best treatment
option.  Cord blood can be especially promising for
patients of racially or ethnically diverse backgrounds.
Patients needing a transplant quickly could also be
helped. 

Learn how umbilical cord blood can help others.  Public
donations, directed donation for an affected family
member, or research studies are examples.  Talk with
your health care provider or visit
http://bloodcell.transplant.hrsa.gov or
www.bethematch.org to learn more.  Your decision can
help save someone’s life.



Delivery Record

Baby’s Name __________________________Gender ___

Date of Birth ___________Time of Birth ______________

Place of Birth_________________Weight ___Length ___

Delivered By ____________________________________

Support Person _________________________________

Baby Doctor ____________________________________

APGAR Score _____1 min. _____5 min.

Time____Labor started ____Infant born

____Membranes ruptured ____Placenta delivered

____Cervix completely dilated

Anesthesia Used Y N Type___________________

Monitor Used Y N

Delivery Spontaneous Breech

Vacuum Forceps Cesarean Section

Complications___________________________________

______________________________________________

______________________________________________

Mother’s Blood Type _________Allergies _____________

______________________________________________

______________________________________________

31



32

Your Newborn

NEWBORN TESTING
The very first test, APGAR, is done when your baby is
born and again 5 minutes later.  The highest score is 10
but any score over 7 means your baby is doing well.  A
score of 6 or below means the doctor and staff may
need to help your baby.

FIRST CHECK-UP
Right after your baby is born the hospital staff will:
� Clean the baby.

� Clamp the umbilical cord.

� Put antibiotic drops or ointment into each eye.

� Take the baby’s footprints.

Before leaving the hospital, your baby will receive an
immunization for Hepatitis B, a hearing test, and a blood
test to check for rare disorders.

Some babies develop jaundice (yellowing of the skin) in
the first 1–3 days.  Mild jaundice is common in newborns
and should clear up within a few days.

Call your insurance company to add your baby to the
coverage.

Register your baby for a social security number.
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TAKING CARE OF YOURSELF
Adjusting to life with a new baby may take some time.
It’s important to remember that you need to take care of
yourself as well as your baby.  Plan your first medical
checkup within six weeks after your baby is born.

Even for experienced parents, the first month is a difficult
time.  New moms and dads have much to learn—and
quickly!  Share the work.  Don’t expect that you will do
everything right the first time.  You may not feel prepared
for this new role.  You may be worn out by baby’s needs
and have emotional ups and downs.

Try these tips to cope with your baby’s needs:
� Try to sleep when your baby sleeps.

� Take a break if you feel stressed.  Ask a partner or
friend to watch the baby while you go for a walk, call
a friend, or just take some time out.

Mild depression that lasts 2 weeks is common.  Talk to a
family member, or friend about your feelings.
Call your doctor if: 
� Your sadness does not go away.

� You are extremely sad.

� You are unable to take care of yourself or your baby.

You might have postpartum depression, a serious
condition.
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TAKING CARE OF BABY
Each baby is unique, yet all follow a basic pattern as they
grow and develop.  Your baby needs to be wholly loved
and totally cared for.

� Decide before you give birth if you will breast-feed or
bottle feed your baby.  Breast-feeding ensures the best
health and development of your baby.  Breast milk is
always warm and ready when baby is hungry.  It is easy
to digest.  It protects baby from some germs.  Breast-fed
babies have fewer allergies.  Breast milk costs less and is
more convenient.   The American Academy of Pediatrics
and the US Surgeon General recommend
breastfeeding. 

If you use formula, follow your doctor’s instructions as
to what kind and how much.  Follow label directions
carefully.  Hold your baby during feeding; physical
contact is important to newborns.

� Newborns can best see objects 12–18 inches away;
they enjoy watching a parent’s face.  Newborns
respond the most to eye contact.

� Newborns can hear and are startled by loud sounds.
At 1 month they know their parents’ voices and may
smile when spoken to in a gentle tone.  Sing, coo, and
talk to your baby often.  Play soft, calming music.



� In most cases, health providers show you how to
bathe your baby and take care of the umbilical cord.
They also explain care of the penis if baby is
circumcised (surgical removal of the male foreskin).  A
bath every day or two is fine, but clean the mouth
and diaper area at least daily.  Test bath water to
make sure it is not too hot.  Never leave a baby alone
in the bath for even a second!

� Newborns cry to let you know they are hungry, wet,
hot, cold, or in some way uncomfortable.  Some cry
more than others. 

� You will soon understand your baby’s "language."
Act quickly to soothe and calm your baby and take
care of needs.  You won’t "spoil" your baby.  Instead,
your baby will feel loved and safe.  Babies thrive in
peaceful, happy homes.

� Infants usually have a few stools a day.  Don’t worry if
they miss a day or two.  Stools of breast-fed babies
are odorless and look like yellow applesauce.  Stools
of formula-fed babies are smelly and more firm.  They
range in color from yellow to dark brown.  Change
your baby when soiled and when wet.  Use a
disposable wipe or washcloth to keep the area clean.
This will prevent irritation or rash.  Wipe a girl from
front to back.  This keeps stool bacteria from getting
into the urinary opening and causing infection.
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� Sleep times vary greatly.  Most infants sleep about 14
out of 24 hours.  They rarely have regular sleep
patterns until later. 
• Place your newborn on its back to sleep, never on
the stomach or side.  

• A separate crib in your bedroom is the safest
place for your newborn to sleep. 

• Use a firm crib mattress covered by a sheet. 

• Keep soft objects and loose bedding out of the
crib.

• Baby's face and head should stay uncovered
during sleep.

� Use clothing that is comfortable and easy to change.
Outdoor air is fine in good weather.  Cover the baby’s
head with a cap if it is cool, a sun
hat if it is sunny.  Feel the body,
not just the hands, to check if
baby is dressed warm enough.

� Bonding is the loving tie
between you and your baby.  
A child must bond with loving
parents for healthy physical,
mental, and emotional
development.  Nothing is more
important.  Children bond with
the people who protect, love,
care for, and guide them.



RECOGNIZING ILLNESS IN YOUR BABY
Call your baby’s doctor immediately if you sense
something is wrong, or for the following signs or
symptoms:
� Changes in breathing—fast, uneven, labored, or when
breathing seems to stop.

� Fever: a rectal temperature of over 100.5 degrees F.

� Undue crying, especially if there are other symptoms.

� Vomiting forcefully, especially if it contains green bile
or blood.

� Blood in urine or bowel movements, or bleeding from
cord or circumcision.

CALL 911 IMMEDIATELY if these symptoms are present:
� Persistent blueness, especially around the mouth.

� Loss of consciousness.

� Seizure.

� No breathing.
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KEEPING BABY SAFE
The world is full of hazards for helpless, fragile infants.
We must know and sense what is not safe.  Here are a
few of the things you will need to watch out for.  They
can cause injury, and even death, to infants.

� When in a car, place your baby in a rear-facing infant
car seat.  Fasten them securely in the back seat of the
car.

� Make sure used or hand-me-down equipment (car
seats, strollers, toys, cribs) were not recalled for safety
reasons.  Check recalled products at 800-638-2772 or
www.cpsc.gov.

� Never leave small objects or plastic bags within
baby’s reach.  Baby could choke or suffocate.

� Never leave your baby alone on a bed or changing
table.  Baby may fall and sustain a tragic injury.

� Install smoke and carbon monoxide detectors.  Use
flame-retardant sleepwear.

� Beware of dogs.  Protect children from all animals.

� Do not leave small children alone with a newborn.
Baby could be hurt by accident.

� Handle baby gently and carefully.
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� Keep your home smoke free.  Children exposed to
second hand smoke have more problems with
allergies and asthma and more ear and upper
respiratory tract infections.  They also have a higher
rate of SIDS.

� Know your coping level. Some babies cry more than
others.  Do all you can to comfort your baby—rock
him, walk with him, take him for a ride in a car or
stroller, offer a pacifier.

If you have had all you can take, give yourself a break.
Put your baby in a safe place like the crib.  Go to
another room.  It is better to let baby cry than take
the chance that you might hurt him when you are
angry.  If you need to, find a person you can trust to
care for your baby for awhile.  Call your doctor if you
feel you are losing control.

NEVER, EVER SHAKE A BABY.  Shaking may cause
brain damage, blindness or death.

Sudden Infant Death Syndrome (SIDS)
SIDS is the sudden death of what seemed to be a
healthy infant.  It occurs from birth to 1 year of age.  The
cause is not known.  Put your baby to sleep on her/his
back.  Placing baby on its stomach could increase the
chances of suffocation or SIDS.  Offering a pacifier at nap
time and bedtime is also recommended for the first year.
Also, avoid overheating.
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Help and Information

Alcohol related problems
800-622-2255, www.aa.org
American Academy of Pediatrics Child Health Information
www.aap.org
American Dietetic Association Consumer Nutrition Hot Line
800-877-1600, www.eatright.org
Domestic Violence 24 hr. Hotline 
800-799-7233, TTY 800-787-3224, www.ndvh.org
Drug-related problems  800-662-4357, Spanish 877-767-
8432, TTY 802-228-0427, www.csat.samhsa.gov
Immunization Hotline  800-232-4636, 
TTY 800-243-7889, www.cdc.gov/vaccines.org
March of Dimes Resource Center  
888-663-4637, TTY 914-997-4764, www.modimes.org
National STD & AIDS Hotline 800-227-8922, Spanish
800-344-7432, TTY 800-243-7889,www.ashastd.org
National Women's Health Information Center 
800-994-9662, www.womenshealth.gov
National Women’s Health Resource Center
877-986-9472, www.healthywomen.org
Planned Parenthood Federation 
800-230-7526, www.plannedparenthood.org
To quit smoking
www.helppregnantsmokersquit.org
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